Практическая работа
Симуляция жидкостей и газов. Основные принципы симуляции жидкостей и газов и их применение в симуляции физики

Цель работы
Изучить основные принципы симуляции жидкостей и газов в интерактивных приложениях и создать простую сцену в Unity, в которой будут реализованы:
1 визуальная имитация жидкости
2 плавучесть объекта в жидкости
3 воздействие газа или воздушного потока на объекты
4 визуальные эффекты пара, дыма, газа и брызг
5 настройка параметров физической среды через Inspector

Планируемые результаты
После выполнения практической работы студент должен:
1 понимать различие между симуляцией жидкости и симуляцией газа
2 знать, какие параметры влияют на поведение жидкостей и газов
3 уметь создавать простую сцену с водой и газовой средой
4 уметь использовать систему частиц для имитации пара, дыма, газа и брызг
5 уметь применять Rigidbody, Collider и Trigger в физической симуляции
6 уметь управлять параметрами среды через скрипты
7 понимать, где подобные симуляции используются в играх, тренажерах и визуализациях

Оборудование и программное обеспечение
1 компьютер
2 Unity
3 шаблон 3D проекта
4 мышь и клавиатура

Краткие теоретические сведения
Что такое симуляция жидкости
Симуляция жидкости — это моделирование поведения текучей среды, например воды, масла, лавы или другой жидкости. Жидкость может:
1 течь
2 растекаться
3 изменять форму
4 взаимодействовать с препятствиями
5 создавать волны, брызги и испарение
В учебных проектах и во многих играх вместо сложной математической модели часто используются упрощенные методы:
1 анимация формы
2 изменение масштаба объекта
3 визуальные эффекты через Particle System
4 триггеры
5 скрипты, создающие иллюзию поведения жидкости
Что такое симуляция газа
Симуляция газа используется для имитации:
1 дыма
2 пара
3 тумана
4 утечки газа
5 воздушного потока
6 облаков
Газ отличается от жидкости тем, что:
1 быстрее распространяется в пространстве
2 легче меняет форму
3 чаще визуализируется через частицы
4 сильнее зависит от скорости, направления и турбулентности потока
Где это используется
Симуляция жидкостей и газов применяется:
1 в играх
2 в анимации
3 в обучающих тренажерах
4 в инженерных симуляторах
5 в VR и AR приложениях
6 в фильмах и интерактивных эффектах

Практическое задание
Задание
Создать сцену, в которой:
1 есть резервуар или область с водой
2 реализована визуальная имитация жидкости
3 есть объект, реагирующий на воду
4 реализована система газа или воздушного потока
5 объекты реагируют на поток газа
6 добавлены эффекты пара, дыма или брызг
7 можно менять параметры среды через Inspector
Ход работы
Часть 1 Подготовка сцены
Шаг 1 Создание проекта
1 Запустите Unity Hub
2 Создайте новый 3D проект
3 Назовите проект FluidGasSimulation
4 Откройте сцену SampleScene
Шаг 2 Создание поверхности
1 В окне Hierarchy нажмите правой кнопкой мыши
2 Выберите 3D Object → Plane
3 Переименуйте объект в Ground
4 Установите Position:
· X = 0 
· Y = 0 
· Z = 0
5 Увеличьте поверхность при необходимости: 
· Scale X = 3 
· Scale Y = 1 
· Scale Z = 3 
Шаг 3 Создание резервуара
1 Создайте несколько объектов Cube
2 Соберите из них резервуар
3 Сделайте:
· дно 
· левую стенку 
· правую стенку 
· заднюю стенку
4 Переднюю стенку можно сделать ниже или убрать, чтобы было видно содержимое 
Часть 2 Создание жидкости
Шаг 4 Создание объекта воды
1 Создайте объект Cube
2 Назовите его Water
3 Поместите его внутрь резервуара
4 Установите размеры так, чтобы он выглядел как слой воды
Пример:
· Scale X = 3 
· Scale Y = 0.5 
· Scale Z = 3 
Шаг 5 Создание материала воды
1 В окне Project создайте новый материал
2 Назовите его WaterMaterial
3 Установите голубой или синий цвет
4 Если возможно, добавьте прозрачность
5 Перетащите материал на объект Water
Шаг 6 Анимация воды
Создайте скрипт WaterWave.cs и добавьте его к объекту Water.
using UnityEngine;

public class WaterWave : MonoBehaviour
{
    private Vector3 startScale;
    private Vector3 startPosition;

    public float waveSpeed = 2f;
    public float waveHeight = 0.05f;

    void Start()
    {
        startScale = transform.localScale;
        startPosition = transform.position;
    }

    void Update()
    {
        float wave = Mathf.Sin(Time.time * waveSpeed) * waveHeight;

        transform.localScale = new Vector3(
            startScale.x,
            startScale.y + wave,
            startScale.z
        );

        transform.position = new Vector3(
            startPosition.x,
            startPosition.y + wave / 2f,
            startPosition.z
        );
    }
}
Что делает скрипт
1 изменяет высоту воды
2 создает эффект колебания поверхности
3 делает жидкость визуально живой
Часть 3 Создание плавучего объекта
Шаг 7 Создание объекта
1 Создайте объект Sphere или Cube
2 Назовите его FloatingObject
3 Разместите его над водой
Шаг 8 Добавление физики
1 Выделите объект FloatingObject
2 Нажмите Add Component
3 Добавьте Rigidbody
4 Убедитесь, что включена гравитация
Шаг 9 Создание зоны воды
1 Выделите объект Water
2 Добавьте компонент Box Collider
3 Включите параметр Is Trigger
Шаг 10 Настройка тега
1 Выделите объект Water
2 В верхней части Inspector откройте список Tag
3 Создайте новый тег Water
4 Назначьте этот тег объекту Water
Шаг 11 Скрипт плавучести
Создайте скрипт FloatInWater.cs и добавьте его к объекту FloatingObject.
using UnityEngine;

public class FloatInWater : MonoBehaviour
{
    public float floatForce = 10f;
    private Rigidbody rb;
    private bool inWater = false;

    void Start()
    {
        rb = GetComponent<Rigidbody>();
    }

    void FixedUpdate()
    {
        if (inWater)
        {
            rb.AddForce(Vector3.up * floatForce, ForceMode.Force);
        }
    }

    private void OnTriggerEnter(Collider other)
    {
        if (other.CompareTag("Water"))
        {
            inWater = true;
        }
    }

    private void OnTriggerExit(Collider other)
    {
        if (other.CompareTag("Water"))
        {
            inWater = false;
        }
    }
}
Результат
Когда объект попадает в область воды, на него действует выталкивающая сила.
Часть 4 Создание системы ветра
Шаг 12 Создание источника ветра
1 Создайте пустой объект
2 Назовите его WindZone
3 Разместите его рядом со сценой
Шаг 13 Создание зоны воздействия
1 Добавьте компонент Box Collider
2 Включите Is Trigger
3 Растяните Collider так, чтобы он охватывал область действия ветра
Шаг 14 Скрипт ветра
Создайте скрипт WindEffect.cs и добавьте его к объекту WindZone.
using UnityEngine;

public class WindEffect : MonoBehaviour
{
    public Vector3 windDirection = new Vector3(1f, 0f, 0f);
    public float windStrength = 5f;

    private void OnTriggerStay(Collider other)
    {
        Rigidbody rb = other.GetComponent<Rigidbody>();

        if (rb != null)
        {
            rb.AddForce(windDirection.normalized * windStrength, ForceMode.Force);
        }
    }
}
Что делает скрипт
1 определяет объекты внутри зоны
2 проверяет наличие Rigidbody
3 прикладывает к ним силу в выбранном направлении
Часть 5 Создание визуальной системы пара или дыма
Шаг 15 Создание системы частиц
1 В Hierarchy нажмите правой кнопкой мыши
2 Выберите Effects → Particle System
3 Назовите объект Steam или Smoke
4 Разместите его над водой или рядом с источником
Шаг 16 Настройка системы частиц
Пример параметров:
1 Duration = 5
2 Looping = включено
3 Start Lifetime = 2–4
4 Start Speed = 0.5–1.5
5 Start Size = 0.2–0.5
6 Start Color = белый или светло-серый
7 Shape = Cone
8 Emission = 20–50
Дополнительная настройка
Можно включить:
1 Color over Lifetime
2 Size over Lifetime
3 Noise
4 Velocity over Lifetime
Это делает пар или дым более реалистичным.
Часть 6 Создание системы газа
В этой части создается отдельная система, которая имитирует газ, например:
1 утечку газа
2 струю пара
3 дым
4 направленный поток воздуха
Система будет состоять из:
1 визуального эффекта
2 зоны воздействия
3 скрипта физического влияния
Вариант А Простая визуальная система газа
Шаг 17 Создание объекта газа
1 В Hierarchy нажмите правой кнопкой мыши
2 Выберите Effects → Particle System
3 Переименуйте объект в GasSystem
4 Разместите его в нужной точке сцены
Шаг 18 Базовая настройка частиц газа
Выделите GasSystem и настройте параметры:
1 Duration = 5
2 Looping = включено
3 Start Lifetime = 3
4 Start Speed = 1
5 Start Size = 0.3
6 Start Color = светло-серый, беловатый или светло-зеленый
7 Simulation Space = World
8 Max Particles = 300
Шаг 19 Настройка формы газа
1 Откройте модуль Shape
2 Выберите форму:
· Cone для струи 
· Box для объема 
· Sphere для облака 
Для струи удобно:
1 Angle = 10–20
2 Radius = 0.1–0.3
Шаг 20 Настройка эмиссии
1 Откройте Emission
2 Установите Rate over Time = 20–50
Шаг 21 Настройка турбулентности
1 Откройте модуль Noise
2 Включите его
3 Пример параметров:
· Strength = 0.5 
· Frequency = 0.3 
· Scroll Speed = 0.2 
Шаг 22 Настройка изменения размера и прозрачности
1 Включите Size over Lifetime
2 Настройте плавное увеличение размера
3 Включите Color over Lifetime
4 Сделайте постепенное исчезновение газа
Вариант Б Газ, который воздействует на объекты
Шаг 23 Создание зоны воздействия газа
1 Создайте пустой объект
2 Назовите его GasForceZone
3 Разместите его рядом с GasSystem
4 Добавьте компонент Box Collider
5 Включите Is Trigger
Шаг 24 Настройка размеров зоны
Растяните Collider так, чтобы он совпадал с направлением распространения газа.
Шаг 25 Скрипт газа
Создайте скрипт GasForce.cs и добавьте его к объекту GasForceZone.
using UnityEngine;

public class GasForce : MonoBehaviour
{
    public Vector3 gasDirection = new Vector3(1f, 0.2f, 0f);
    public float gasStrength = 3f;

    private void OnTriggerStay(Collider other)
    {
        Rigidbody rb = other.GetComponent<Rigidbody>();

        if (rb != null)
        {
            rb.AddForce(gasDirection.normalized * gasStrength, ForceMode.Force);
        }
    }
}
Что делает скрипт
1 определяет объекты внутри газовой зоны
2 проверяет наличие Rigidbody
3 прикладывает силу в направлении движения газа
Вариант В Газ с изменяющейся мощностью
Можно усложнить систему и сделать поток газа непостоянным.
Измененный скрипт GasForce.cs:
using UnityEngine;

public class GasForce : MonoBehaviour
{
    public Vector3 gasDirection = new Vector3(1f, 0.2f, 0f);
    public float baseStrength = 3f;
    public float fluctuation = 1f;
    public float speed = 2f;

    private void OnTriggerStay(Collider other)
    {
        Rigidbody rb = other.GetComponent<Rigidbody>();

        if (rb != null)
        {
            float dynamicStrength = baseStrength + Mathf.Sin(Time.time * speed) * fluctuation;
            rb.AddForce(gasDirection.normalized * dynamicStrength, ForceMode.Force);
        }
    }
}
Что изменилось
1 сила газа стала переменной
2 поток периодически усиливается и ослабевает
3 симуляция выглядит более естественно
Часть 7 Дополнительное усложнение проекта
Вариант 1 Брызги при попадании объекта в воду
Цель
Сделать так, чтобы при падении объекта в воду появлялись брызги.
Шаг 26 Создание системы брызг
1 Создайте Particle System
2 Назовите объект SplashEffect
3 Разместите его над водой
4 Отключите Play On Awake
Шаг 27 Настройка брызг
Пример параметров:
1 Duration = 1
2 Looping = выключено
3 Start Lifetime = 0.5–1
4 Start Speed = 2–4
5 Start Size = 0.1–0.2
6 Start Color = белый или голубой
7 Emission Burst = 20–30
8 Shape = Cone
Шаг 28 Скрипт брызг
Создайте скрипт SplashOnWater.cs и добавьте его на падающий объект.
using UnityEngine;

public class SplashOnWater : MonoBehaviour
{
    public ParticleSystem splashEffect;

    private void OnTriggerEnter(Collider other)
    {
        if (other.CompareTag("Water"))
        {
            if (splashEffect != null)
            {
                splashEffect.transform.position = new Vector3(
                    transform.position.x,
                    other.bounds.max.y,
                    transform.position.z
                );

                splashEffect.Play();
            }
        }
    }
}
Шаг 29 Привязка эффекта
1 Выделите объект со скриптом
2 Перетащите SplashEffect в поле Splash Effect
Вариант 2 Испарение воды
Цель
Сделать постоянное образование пара над водой.
Шаг 30 Создание пара
1 Создайте новую Particle System
2 Назовите объект SteamEffect
3 Разместите его немного выше воды
Шаг 31 Настройка параметров пара
Пример параметров:
1 Start Lifetime = 2–4
2 Start Speed = 0.5–1
3 Start Size = 0.2–0.4
4 Start Color = белый полупрозрачный
5 Emission Rate = 15–25
6 Shape = Box
7 Noise = включено
Шаг 32 Скрипт испарения
Создайте скрипт SteamController.cs и добавьте его к объекту SteamEffect.
using UnityEngine;

public class SteamController : MonoBehaviour
{
    public float temperature = 50f;
    public float minEmission = 5f;
    public float maxEmission = 50f;

    private ParticleSystem ps;
    private ParticleSystem.EmissionModule emission;

    void Start()
    {
        ps = GetComponent<ParticleSystem>();
        emission = ps.emission;
    }

    void Update()
    {
        float rate = Mathf.Lerp(minEmission, maxEmission, temperature / 100f);
        emission.rateOverTime = rate;
    }
}
Что делает скрипт
1 хранит значение температуры
2 рассчитывает интенсивность испарения
3 увеличивает или уменьшает количество пара
Вариант 3 Разные типы среды
Цель
Показать, как меняется поведение объектов в разных физических условиях.
Можно сделать несколько режимов:
1 обычная вода
2 густая жидкость
3 слабый газ
4 сильный газ
Обычная вода
Пример:
· floatForce = 10 
· waveSpeed = 2 
· waveHeight = 0.05 
Густая жидкость
Можно показать вязкость так:
1 увеличить Drag у Rigidbody
2 увеличить Angular Drag
3 уменьшить скорость волн
4 уменьшить амплитуду
Пример:
· Drag = 3 
· Angular Drag = 2 
Слабый газ
Пример:
· gasStrength = 1 
· Rate over Time = 10 
Сильный газ
Пример:
· gasStrength = 8 
· Rate over Time = 50 
· Noise Strength = 1 
Скрипт переключения режимов
Создайте EnvironmentMode.cs:
using UnityEngine;

public class EnvironmentMode : MonoBehaviour
{
    public WaterWave waterWave;
    public WindEffect windEffect;
    public GasForce gasForce;

    public void SetNormalWater()
    {
        waterWave.waveSpeed = 2f;
        waterWave.waveHeight = 0.05f;
    }

    public void SetDenseLiquid()
    {
        waterWave.waveSpeed = 1f;
        waterWave.waveHeight = 0.02f;
    }

    public void SetWeakGas()
    {
        gasForce.baseStrength = 1f;
    }

    public void SetStrongGas()
    {
        gasForce.baseStrength = 6f;
    }
}
Вариант 4 Управление параметрами через Inspector
Цель
Сделать проект удобным для настройки без редактирования кода.
Какие параметры можно менять
В скрипте WaterWave
1 waveSpeed
2 waveHeight
В скрипте FloatInWater
1 floatForce
В скрипте WindEffect
1 windDirection
2 windStrength
В скрипте GasForce
1 gasDirection
2 gasStrength
или
3 baseStrength
4 fluctuation
5 speed
В скрипте SteamController
1 temperature
2 minEmission
3 maxEmission
Что нужно сделать студенту
1 выделять нужный объект
2 находить публичные параметры в Inspector
3 менять значения
4 запускать сцену
5 наблюдать изменения симуляции
Часть 8 Итоговое расширенное задание
После выполнения всей работы студент должен получить сцену, в которой:
1 есть резервуар с водой
2 вода визуально колеблется
3 объект реагирует на воду и плавает
4 есть система ветра
5 есть система газа
6 газ отображается визуально через Particle System
7 газ воздействует на объекты физически
8 при необходимости добавлены брызги
9 есть испарение воды
10 параметры среды можно менять через Inspector
Варианты итогового мини проекта
Вариант 1 Лаборатория утечки газа
1 из трубы выходит газ
2 газ визуализируется частицами
3 объекты внутри зоны сдвигаются
4 сила утечки регулируется
Вариант 2 Горячий резервуар
1 в емкости находится вода
2 над водой поднимается пар
3 в воду падает объект
4 появляются брызги
5 температуру можно изменять
Вариант 3 Зона физических экспериментов
1 есть вода
2 есть густая жидкость
3 есть слабый поток газа
4 есть сильный поток газа
5 сравнивается поведение одинаковых объектов
Контрольные вопросы
1 Чем жидкость отличается от газа в физической симуляции
2 Почему в учебных проектах часто используется упрощенная симуляция
3 Для чего нужен Rigidbody
4 Для чего используется Trigger Collider
5 Как система частиц помогает имитировать газ или пар
6 Какие параметры влияют на поведение потока газа
7 Что такое плавучесть
8 Для чего используется Noise в Particle System
9 Как можно реализовать испарение воды
10 Где в реальных приложениях применяются симуляции жидкостей и газов
Критерии оценки
Оценка 5
1 сцена полностью создана
2 есть вода и визуальная анимация поверхности
3 объект реагирует на воду
4 реализована система газа
5 реализовано физическое воздействие газа
6 добавлены пар, дым или брызги
7 параметры можно изменять
8 студент понимает, как работает сцена
Оценка 4
1 основные элементы сцены созданы
2 вода и газ работают
3 есть небольшие ошибки в настройке
4 часть эффектов реализована упрощенно
5 студент в целом понимает принцип работы
Оценка 3
1 выполнена только часть задания
2 работает только вода или только газ
3 есть ошибки в логике работы скриптов
4 студенту требуется помощь преподавателя
Оценка 2
1 работа не выполнена
2 сцена не запускается
3 основные компоненты отсутствуют
Вывод
В ходе практической работы была создана сцена, демонстрирующая базовые принципы симуляции жидкостей и газов в Unity. Были реализованы визуальная имитация воды, плавучесть объекта, воздействие ветра и газа, а также эффекты пара, дыма и брызг. В результате студент изучил, как средствами игрового движка можно создавать физически правдоподобные среды и применять их в играх, тренажерах и интерактивных приложениях.

